MANUAL

PROFINET IO Power Hub
With HD2-GTR-4PA.PN
Gateway
With regard to the supply of products, the current issue of the following document is applicable: The General Terms of Delivery for Products and Services of the Electrical Industry, published by the Central Association of the Electrical Industry (Zentralverband Elektrotechnik und Elektroindustrie (ZVEI) e.V.) in its most recent version as well as the supplementary clause: "Expanded reservation of proprietorship"
1 Introduction ................................................................. 6
  1.1 Contents ................................................................. 6
  1.2 Target Group, Personnel .......................................... 6
  1.3 Symbols Used .......................................................... 6

2 Product Specifications .............................................. 8
  2.1 Overview and Application .......................................... 8
  2.2 System Components ................................................. 8
  2.3 Recommended System Combinations ............................ 11
  2.4 Component Overview ............................................... 13
  2.5 Technical Data .......................................................... 14
  2.6 Dimensions ............................................................. 16

3 PROFINET System Integration ................................... 17
  3.1 PROFINET IO Communication Profile ........................... 17
  3.2 Gateway Device Model .............................................. 17
  3.3 Gateway Management Function .................................. 18
  3.4 Supported PROFIBUS PA Device Features ...................... 18
  3.5 Cyclic IO Data of the PROFIBUS PA Devices ................. 19
  3.6 PROFIBUS PA Device Diagnostics ............................... 19

4 Installation and Commissioning ............................... 20
  4.1 Mounting and Dismounting ........................................ 20
  4.2 Shielding/Grounding ................................................ 22
    4.2.1 Connection to Equipotential Bonding System ............ 23
  4.3 Hazardous Area Installation and Use ......................... 24
    4.3.1 Installation in Zone 2, Category 3G ....................... 24
  4.4 Connections ........................................................... 25
  4.5 Gateway Addressing ............................................... 26
  4.6 PROFIBUS PA Device Addressing ............................... 26
  4.7 Gateway Configuration ............................................ 26
9.7 Gateway Documentation ................................................................. 53

10 References ................................................................................... 55
1 Introduction

1.1 Contents
This document contains information that you need in order to use your product throughout the applicable stages of the product life cycle. These can include the following:

- Product identification
- Delivery, transport, and storage
- Mounting and installation
- Commissioning and operation
- Maintenance and repair
- Troubleshooting
- Dismounting
- Disposal

**Note!**
This document does not substitute the instruction manual.

**Note!**
For full information on the product, refer to the instruction manual and further documentation on the Internet at www.pepperl-fuchs.com.

The documentation consists of the following parts:

- Present document
- Instruction manual
- Datasheet

Additionally, the following parts may belong to the documentation, if applicable:

- EU-type examination certificate
- EU declaration of conformity
- Attestation of conformity
- Certificates
- Control drawings
- Additional documents

1.2 Target Group, Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and dismounting lies with the plant operator.

Only appropriately trained and qualified personnel may carry out mounting, installation, commissioning, operation, maintenance, and dismounting of the product. The personnel must have read and understood the instruction manual and the further documentation.

Prior to using the product make yourself familiar with it. Read the document carefully.

1.3 Symbols Used
This document contains symbols for the identification of warning messages and of informative messages.
Warning Messages
You will find warning messages, whenever dangers may arise from your actions. It is mandatory that you observe these warning messages for your personal safety and in order to avoid property damage.

Depending on the risk level, the warning messages are displayed in descending order as follows:

Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.

Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.

Caution!
This symbol indicates a possible fault.
Non-observance could interrupt the device and any connected systems and plants, or result in their complete failure.

Informative Symbols

Note!
This symbol brings important information to your attention.

Action
This symbol indicates a paragraph with instructions. You are prompted to perform an action or a sequence of actions.
2 Product Specifications

2.1 Overview and Application

The Pepperl+Fuchs FieldConnex® Power Hub for PROFINET IO is based on a modular system. The system consists of various motherboards with slots, plug-in modules, e.g., power supplies, diagnostic modules, and a gateway. The gateway couples up to 4 PROFIBUS PA segments to PROFINET IO system interfaces. On the PROFIBUS PA trunk a high energy level is fed to the field devices via device couplers, such as FieldBarriers or Segment Protectors. A dedicated version of the Power Hub (DART) supports the intrinsically safe concept for fieldbus.

In its basic version, the diagnostic module is used to ensure the functional integrity of the Power Hub. The advanced version additionally monitors the physical layer of the 4 PROFIBUS PA segments online, this way enabling the detection of degradation and faults in real-time during operation. Measurement data and alarms are transmitted to the control room. This makes the fieldbus physical layer visible and accessible as an active component in plant asset management systems. Operating personnel are enabled to decide on proactive measures to avoid unwanted situations while the plant is running smoothly. For further information on the diagnostic capabilities, refer to the specific product documentation.

The Power Hub offers various redundancy options such as gateway and power supply redundancy.

A complete tool chain supports the engineering for system integration. A gateway device type manager (DTM) and a web server enable the access to status and diagnostic of infrastructure components and connected field devices. The gateway DTM allows using the DTM of the connected PROFIBUS PA devices for parameterization, access to diagnostic, and status information.
2.2 System Components

Motherboards

The following types of gateway motherboards are available:

- **Compact motherboard MBHC-FB-4.GT**: Slots for 1 gateway HD2-GTR-4PA.PN, 4 simplex power supply modules, and 1 diagnostic module. For further information, refer to the documentation for MBHC-FB-4.GT.

- **Gateway motherboard MB-FB-GTR1**: 2 slots for up to 2 gateway modules HD2-GTR-4PA.PN. The gateway motherboard is designed for the use with Power Hub motherboards holding power supply modules for the supply of PROFIBUS PA segments. The motherboard can be used with a single gateway for simplex coupling to PROFINET IO or with 2 gateways for redundant coupling. At the point of issue of this manual, redundant coupling is not supported yet. For more information, contact your Pepperl+Fuchs representative.

  MB-FB-GTR1 can be used with the following Power Hub motherboards:
  - MBHC-FB-4.HSC* supports 4 simplex segments, redundant bulk power supply
  - MBHC-FB-4R.HSC* supports 4 redundant segments, redundant bulk power supply
  - MBHD-FB-D-4R.GEN supports 4 redundant DART intrinsically safe segments, redundant bulk power supply

  The motherboards are connected with a customized cable that is included in the delivery of the gateway motherboard.

For further information refer to the respective product documentation at www.pepperl-fuchs.com.

Gateway

The PROFINET/PROFIBUS PA gateway module HD2-GTR-4PA.PN connects 4 PROFIBUS PA segments to PROFINET IO on the performance level “real-time RT”. It supports 2 Ethernet-switched ports for PROFINET S2 system redundancy and media ring redundancy based on the media redundancy protocol (MRP).

The gateway features LEDs to diagnose the status of the Ethernet ports, gateway hardware, redundancy, and the PROFIBUS PA segments.

For system integration the software tool "PROFINET GSD generator" is provided. The generator builds a PROFINET GSD including all gateway and PROFIBUS PA device-specific information required for engineering the PROFINET IO system. As input, the GSD files of the PROFIBUS PA devices used in a specific project are required. The PROFINET GSD is generated out of the individual GSD files.

Both, a gateway device type manager (DTM) and a PROFINET communication DTM enable the access and use of the device manufacturer DTMs in order to parameterize and diagnose the individual PROFIBUS PA devices.

A web server provides access to gateway-specific and optional physical layer status read-only information of the 4 segments. Update functionality of gateway firmware is provided.

The gateway is compatible with the motherboards of the following Power Hubs:

- Compact Power Hub KT–MB–GTB–2PS

Application documents for the integration of the PROFINET Power Hub into various control systems are available. For more information, contact your Pepperl+Fuchs representative or visit pepperl-fuchs.com.
**Fieldbus Power Supply Modules**

The fieldbus power supplies supply the PROFIBUS PA segments with power. For different application requirements, dedicated power supply modules are available:

- **HCD2-FBPS-1.500.** Output: 28 V...30 V at 500 mA with an intrinsically safe limited voltage for Zone 2 of \( U_o = 30 \) V
- **HCD2-FBPS-1.23.500.** Output: 21 V...23 V at 500 mA with an intrinsically safe limited voltage for Zone 2 of \( U_o = 24 \) V
- **HD2-FBPS-IBD-1.24.360.** Output: 24 V at 360 mA for intrinsically safe (DART) segments installed in Zone 1

The power supply modules provide full galvanic isolation between the bulk power supply and the PA segments. The modules offer system reliability for applications where cabling and wiring are routed through critical or harsh electrical environments, with full protection from electromagnetic interference (EMI).

Power supply modules are plugged into the motherboard slots and can be exchanged during system operation. In redundant configuration, load is shared between 2 power supply modules.

**Diagnostic Modules**

**Basic Diagnostic Module**

The basic diagnostic module provides basic system diagnostics. It monitors the input voltage of the bulk power supply and each segment for overload and short circuit conditions. Each power supply module is checked for proper function. Power supply modules operating in redundant configuration are checked for compatibility. LEDs indicate both status and fault information. This information can be transmitted via volt-free contact.

For further information refer to the manual *"Basic Diagnostic Module*” at www.pepperl-fuchs.com.

**Advanced Diagnostic Module**

The advanced diagnostic module is a comprehensive measurement tool for the PROFIBUS PA physical layer, and supports commissioning, online monitoring, and maintenance tasks. The module provides the exact segment and individual device data needed for detection of changes in the fieldbus physical layer. Segment measurements include fieldbus voltage and load current. Device-specific measurements are signal level, noise, and jitter. All data is transmitted to the control room via Ethernet. The basic edition of the diagnostic manager displays all data in an easy-to-use user interface. The professional edition of the diagnostic manager offers extended software functions: the commissioning wizard generates automated reports; the software displays clear-text messages for troubleshooting of out-of-specification behavior.

For further information refer to the manual *"Advanced Diagnostic Module*” at www.pepperl-fuchs.com.
2.3 Recommended System Combinations

Simplex Power Feed for 4 Segments with Single Gateway

The one-board simplex system with single gateway coupling consists of the following components:

- Combined Power Hub gateway motherboard MBHC–FB–4.GT
- HD2-GTR-4PA.PN (x 1)
- Power supply modules (x 4)

Optional components:

- Diagnostic module HD2–DM*
- Surge protectors TPH-LBF-IA1.36.DE* (x 4)
- Earth bar for surge protectors ACC–LBF–EB.4
Redundant Power Feed for 4 Segments with Single Gateway

The redundant system with gateway coupling for ring redundancy or S2 redundancy consists of the following components:

- Combined Power Hub gateway motherboard MBHC–FB–4R.HSC*
- Gateway motherboard MB–FB–GTR1 (x 1)
- HD2-GTR-4PA.PN (x 1)
- Power supply modules (x 8)
- Sub-D cable 9 pins for connecting gateway motherboard and Power Hub motherboard ACC-MB-HGC

Optional components:

- Diagnostic module HD2–DM*
- Surge protectors TPH-LBF-IA1.36.DE* (x 4)
- Earth bar for surge protectors ACC–LBF–EB.4

Figure 2.2 MBHC-FB-4R.HSC motherboard for the redundant supply of 4 segments combined with the MB-FB-GTR1 motherboard and 1 HD2-GTR-4PA.PN gateway module for gateway coupling.
2.4 Component Overview

MB-FB-GTR1* Component Overview

1. Motherboard MB-FB-GTR1*
2. Gateway HD2-GTR-4PA.PN
3. Connections: Volt-free contact alarm and diagnostic bus. Diagnostic link cable ACC-MB-HDC, optional accessory
4. Sub-D interface for the connection of Power Hub motherboards
5. Rotary switches for gateway addressing, x1, x10, x100
6. Earth connection
7. Mounting slot for DIN mounting rail
2.5 Technical Data

System Overview

<table>
<thead>
<tr>
<th>Ambient conditions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature</td>
<td>-40 ... 60 °C (-40 ... 140 °F) vertically mounted, -40 ... 70 °C (-40 ... 158 °F) horizontally mounted</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-40 ... 85 °C (-40 ... 185 °F)</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>&lt; 95 % non-condensing</td>
</tr>
<tr>
<td>Shock resistance</td>
<td>15 g 11 ms</td>
</tr>
<tr>
<td>Vibration resistance</td>
<td>1 g, 10 ... 150 Hz</td>
</tr>
<tr>
<td>Pollution degree</td>
<td>max. 2, according to IEC 60664</td>
</tr>
<tr>
<td>Corrosion resistance</td>
<td>acc. to ISA-S71.04-1985, severity level G3</td>
</tr>
</tbody>
</table>

Mechanical specifications

| Degree of protection | IP20 |

Figure 2.4 HD2-GTR-4PA.PN component identity
## PROFINET IO Power Hub

**Product Specifications**

### Mounting
- motherboard mounting

### Standard conformity
- Electromagnetic compatibility: NE 21:2011
- Degree of protection: IEC 60529
- Fieldbus standard: IEC 61158-2
- Shock resistance: EN 60068-2-27
- Vibration resistance: EN 60068-2-6

### Data for application in connection with Ex-areas
- Statement of conformity: TUV 15 ATEX 7735 X
- Group, category, type of protection, temperature class: II 3 G Ex ec IIC T4 Gc
- International approvals: IECEx approval
- Approved for: Ex ec IIC T4 Gc

## HD2-GTR-4PA.PN

### Supply
- Rated voltage: 19.2 ... 35 V SELV/PELV
- Rated current: typ. 135 mA
- Power dissipation: approx. 3.5 W

### Fieldbus interface
- Fieldbus type: PROFIBUS PA
- Number of segments: 4
- Number of devices per segment: max. 36, physical connections, depending on the device couplers used

### Electrical isolation
- CH/PROFIBUS DP: functional insulation acc. to IEC 61010, rated insulation voltage 50 V_{eff}
- PROFIBUS DP/Supply
- CH/CH
- CH/Ethernet
- All circuits/FE
- Ethernet/Supply

## MB-FB-GTR1*

### Supply
- Rated voltage: 19.2 ... 35 V SELV/PELV
- Rated current: 2 ... 3 A

### Indicators/operating means
- Fault signal: VFC alarm output via connectors
- Rotary switch: bus addressing, gateway-specific
2.6 Dimensions

Component Dimensions

<table>
<thead>
<tr>
<th>Accessories</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACC-MB-HDC</td>
<td>Diagnostic link cable, length 6 cm</td>
</tr>
<tr>
<td>ACC-MB-HGC</td>
<td>Sub-D cable. 9 pins for connecting the gateway motherboard and Power Hub motherboard. Included in the delivery of gateway motherboards.</td>
</tr>
</tbody>
</table>

Overview of Ordering Information

| HD2–GTR–4PA.PN       | PROFINET to PROFIBUS PA gateway module, 4 PROFIBUS PA segments.             |
| MB-FB-GTR1*          | Motherboard for gateway redundancy, slots for 2 gateway modules.            |

Figure 2.5 All dimensions in millimeters and without tolerance indication.
3 PROFINET System Integration

3.1 PROFINET IO Communication Profile

The HD2-GTR-4PA.PN is compatible with PROFINET communication profile CP3/5 according to IEC/EN 61784–2:2015. This communication profile describes the performance characteristics capabilities of a PROFINET device.

**Important PROFINET/PA Performance Characteristics**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conformance class</td>
<td>CC B, process automation</td>
</tr>
<tr>
<td>Application class</td>
<td>Supports process-automation-specific requirements</td>
</tr>
<tr>
<td>Communication class</td>
<td>Supports PROFINET RT communication</td>
</tr>
<tr>
<td>Communication relationship</td>
<td>Supports 1 IO AR with 1 input CR and 1 output CR with 1440 bytes each</td>
</tr>
<tr>
<td>Physical layer</td>
<td>100Mbit/s, 10Mbit/s full duplex with auto crossover and auto negotiation</td>
</tr>
<tr>
<td>Bridging internal switch</td>
<td>4 priority queues, cut-through switching is not supported</td>
</tr>
<tr>
<td>Bridging VLAN</td>
<td>Supports virtual local area network (VLAN) priority handling</td>
</tr>
<tr>
<td>Precision time synchronization</td>
<td>Not supported</td>
</tr>
<tr>
<td>Media redundancy</td>
<td>Supports loop prevention, ring redundancy, MRP.</td>
</tr>
<tr>
<td>Device redundancy</td>
<td>Single gateway, redundant controller, NAP S2</td>
</tr>
<tr>
<td>Communication features</td>
<td>Fast startup, supervisor AR, implicit AR</td>
</tr>
<tr>
<td>SNMP</td>
<td>Supports SNMPv1, SNMPv2c</td>
</tr>
<tr>
<td>LLDP</td>
<td>Supports neighborhood discovery</td>
</tr>
<tr>
<td>Configuration in run</td>
<td>Not supported</td>
</tr>
<tr>
<td>SNTP</td>
<td>Support of time synchronization</td>
</tr>
<tr>
<td>Shared device</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

3.2 Gateway Device Model

The PROFINET/PA gateway is based on the PROFINET IO device model and represents a modular device that can be used for process data addressing.

The gateway complies with “PROFIBUS Integration in PROFINET IO, Amendment 1 to Fieldbus Integration into PROFINET IO”.

According to the PROFINET IO device model, each device has slots for inserting modules. Each module consists of subslots for inserting submodules.
Mapping PROFIBUS PA Device Data to PROFINET

All information provided by the gateway is accessible using a fixed slot/subslot addressing. Most of the accessible data is handled by system-specific software. Therefore, no detailed knowledge on data mapping is required.

Slot 0 contains the "device access point" (DAP) with all gateway-specific information, including information on the 2 Ethernet ports.

Slots 1 ... 4 contain the "fieldbus access point" (FAP) with all PROFIBUS-PA-specific information, such as, e.g., master parameters.

Slots 053 ... 099 contain PROFIBUS PA device data from PA segment 1, device address 3 ... 49*

Slots 103 ... 149 contain PROFIBUS PA device data from PA segment 2, device address 3 ... 49*

Slots 153 ... 199 contain PROFIBUS PA device data from PA segment 3, device address 3 ... 49*

Slots 203 ... 249 contain PROFIBUS PA device data from PA segment 4, device address 3 ... 49*

* Addresses 50 ... 126 are not used
3.3 Gateway Management Function

The gateway supports SNMPv1 and SNMPv2c to exchange gateway and network-specific management information with dedicated tools. The data content is defined in various specifications and allows mainly to monitor the health status of network components, provided that information is organized in so-called management information bases (MIBs) that various standards define. Supported MIBs are:

- MIB-II
- LLDP-MIB
- LLDP-EXT-DOT3-MIB
- LLDP-EXT-PNIO-MIB

The gateway supports mandatory information defined in the specific standard.

3.4 Supported PROFIBUS PA Device Features

PROFIBUS PA devices complying with PROFIBUS DP-V0 and DP-V1 are supported. The gateway supports following PROFIBUS PA communication features:

- SET_PRM
- SET_CFG
- C2 communication
- Diagnostics, including structured diagnostics
- Module PRM parameters for PROFIBUS PA devices not supporting structured PRM
- PROFIBUS I&M functions
- RD_INPUT
- RD_OUTPUT
- GET_CFG
- Acyclic C1 communication
- Set_Slave_Address

The following PROFIBUS features are not supported because PROFIBUS PA devices cannot support them:

- Alarms
- EXT_PRM
- Module PRM parameters for PROFIBUS PA devices using structured PRM
- PROFIBUS PA channel diagnostics

3.5 Cyclic IO Data of the PROFIBUS PA Devices

The PROFIBUS PA device slot data is mapped into gateway subslots.

For each PROFIBUS PA segment a maximum of 46 devices can be addressed, each supporting 246 bytes of input and output data. The device address range is defined from 3 … 49. For each PROFIBUS PA segment, a fixed slot cluster is defined with a length of 46 slots. For more information, see chapter 3.2.

Example: Device data of PROFIBUS PA device address 5 in segment 3 is available in slot 155.

3.6 PROFIBUS PA Device Diagnostics

PROFIBUS PA SLAVE_DIAG data is mapped to PROFINET diagnostics alarms as defined in the PROFIBUS PA GSD file. Channel-specific diagnostics for PROFIBUS PA devices is not supported.
4 Installation and Commissioning

In the following section you find information on how to install and commission the device in your fieldbus topology.

**Danger!**

Explosion hazard from exposure to potentially explosive gas atmosphere

If the device is installed in Zone 2 without mounting it in a sufficiently suitable enclosure, gas, dust, water or other external interferences can cause the live device to spark. The sparks can ignite the surrounding potentially explosive atmosphere.

Only mount the device in an enclosure with degree of protection IP54 according to IEC/EN 60529. The enclosure must have an EU declaration of conformity according to the ATEX Directive for at least equipment category 3G.

**Danger!**

Explosion hazard from exposure to potentially explosive dust atmosphere

If the device is installed in Zone 22 without mounting it in a sufficiently suitable enclosure, dust, water or other external interferences can cause the live device to spark. The sparks can ignite the surrounding potentially explosive atmosphere.

Only mount the device in a suitable enclosure. The enclosure must have an EU declaration of conformity according to the ATEX Directive for at least equipment category 3D.

**Danger!**

Explosion hazard from live wiring

If you connect or disconnect energized non-intrinsically safe circuits in a potentially explosive atmosphere, sparks can ignite the surrounding atmosphere.

Only connect or disconnect energized non-intrinsically safe circuits in the absence of a potentially explosive atmosphere.

**Note!**

*Read the instruction manual first!*

Before you install and commission this product: Read the instruction manual for this product carefully. Make sure you have understood all information that is relevant for your application.

4.1 Mounting and Dismounting

**Danger!**

Danger to life from wrong mounting and installation

Incorrect mounting and installation of the device can compromise its function and its electrical safety.

- Observe the safety instruction in the instruction manual.
- Observe the information in the manual.
Mounting of Fieldbus Motherboards on DIN Mounting Rail

In order to mount a motherboard on a DIN mounting rail, proceed as follows:

1. Place the motherboard on the DIN mounting rail.
2. Tighten the two fastening screws to attach the motherboard on the DIN mounting rail.

![Mounting screws](image)

The motherboard has been mounted.

Mounting Plug-In Modules on the Motherboard

***Caution!***

Property damage from wrong mounting

The Power Hub motherboard includes a dedicated connection slot for the HD2-DM diagnostic modules labeled “Diagnostic Module only”. Using this slot for mounting the wrong type of module can cause property damage on the module or the motherboard.

Do not try to plug other modules into this connection slot.

To install a new plug-in module on the motherboard, proceed as follows:

1. Carefully center the polarization holes and mate the 2 connectors, then gently press down the module.
2. Push down the red Quick Lok bars on each side of the module to fix it to the panel. No tools required.
The new module has been installed.

Dismounting Modules from the Motherboard

To dismount a module from the motherboard, proceed as follows:

Pull up the red Quick Lok Bars on each side of the module and carefully lift off the entire module.

The module has been removed from the motherboard.

4.2 Shielding/Grounding

Figure 4.1 Stylized composition of the grounding

Tip

Earth Connection

Ensure that the grounding practice applied is well-planned and consistent. Ensure a clean earth at all times.

The Ethernet cable shields are directly connected to the grounding terminal. We recommend to connect the grounding terminal to earth in order to achieve the highest protection against electromagnetic interference (EMI).

If the Ethernet cable leads into a hazardous area, the grounding terminal has to be connected to protective earth.

It may be necessary to ground all exposed metal parts as a matter of course.
4.2.1 Connection to Equipotential Bonding System

Caution!
Risk of electric shock or property damage from inadequate grounding

If you fail to connect all metal parts of the device to protective local earth correctly, this could result in potential equalization currents. These currents could hurt operating personnel or cause property damage.

The grounding terminal is not a safety earth: Do not use the grounding terminal to ground exposed metal parts. Ground exposed metal parts of the device separately. Ensure that a correct grounding is guaranteed at all times.

All shield connections are internally connected to the "Shield/Screen GND" grounding terminal.

Connecting the Ground Connection Cable

Note!
Use a cable with a minimum cross core section of 4 mm².

1. Connect the ground cable to a cable lug.
2. Position the cable lug over the ground connection clamp with the cable pointing downwards.
3. Screw the cable lug to the ground connection clamp with 2 toothed lock washers inserted between screw, lug, and clamp as illustrated:

Figure 4.2 Connecting the ground connection cable

1. Screw
2. Toothed lock washer
3. Cable lug
4. Ground connection clamp on motherboard

4. Tighten the screw with a torque of 1.5 Nm.

→ The cable lug is properly attached and cannot come loose.

Connect the "Shield/Screen GND" grounding terminal to an equipotential bonding system.
4.3 Hazardous Area Installation and Use

4.3.1 Installation in Zone 2, Category 3G

**Danger!**

Explosion hazard from exposure to potentially explosive gas atmosphere

If the device is installed in Zone 2 without mounting it in a sufficiently suitable enclosure, gas, dust, water or other external interferences can cause the live device to spark. The sparks can ignite the surrounding potentially explosive atmosphere.

Only mount the device in an enclosure with degree of protection IP54 according to IEC/EN 60529. The enclosure must have an EU declaration of conformity according to the ATEX Directive for at least equipment category 3G.

**Danger!**

Explosion hazard from damaged electronic components

Premature wear of electronic components in a device that was previously used in a general electrical installation can cause sparks that can ignite the surrounding potentially explosive atmosphere.

Never install devices that have already been operated in general electrical installations in electrical installations used in combination with hazardous areas!

**Danger!**

Explosion hazard from exposed conductors

Exposed conductors of inadequately attached cables can cause sparks that can ignite the surrounding potentially explosive atmosphere.

When installing the device ensure that the cables are adequately attached.

**Danger!**

Explosion hazard from connection damage

Manipulating connections outside of the specified ambient temperature range can lead to material damage, resulting in an unwanted failure of the connection. This could result in an increased explosion hazard in potentially explosive atmospheres.

Only manipulate connections in the specified ambient temperature range.

Temperature range: -5 °C ... +70 °C

PROFINET Power Hub may be installed in Zone 2, equipment category 3G. The type of protection is Ex ec (increased safety), gas groups IIC, IIB, or IIA.

Depending on the type of power supply modules used, different topologies and Zone 2 installations can be implemented. The fieldbus trunk is always rated Ex ec for Zone 2 applications. Connecting the PROFINET Power Hub with the Pepperl+Fuchs Segment Protectors allows for hot swapping of field devices.
4.4 Connections

1. RJ45 Ethernet for PROFINET
2. RJ45 Ethernet for PROFINET
3. Grounding terminal
4. Connections: Volt-free contact alarm and diagnostic bus. Diagnostic link cable ACC-MB-HDC, optional accessory
5. Sub-D connection to Power Hub motherboard MBHC-FB-4*.HSC* using ACC-MB-HDC link cable
4.5 Gateway Addressing

The IP address and device name assignment for the gateway is handled automatically by the control system, using standard PROFINET engineering procedures. The address switches on the motherboards are only used for maintenance purposes. For normal operations, the control switch position must be set to "0.0.0".

In addition, the IP address can be assigned to the gateway by using a DHCP server or a DHCP tool.

4.6 PROFIBUS PA Device Addressing

Before you connect the devices to the PROFIBUS PA segments, ensure you assign the bus addresses of the PROFIBUS PA devices first. Valid addresses are from 3 ... 49 for each of the 4 PROFIBUS PA segments. A PROFIBUS PA device with an address above 49 is not included in cyclic data exchange. Acyclic data exchange is however possible.
4.7 Gateway Configuration

You can configure the gateway only via the PROFINET IO engineering station. In order to view the parameters in read-only status, use the web server or the gateway device type manager.

4.8 Gateway Device Parameters (DAP Submodules)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADM alarm observer</td>
<td>Disables/enables the mapping of the advanced physical layer alarms to PROFINET IO alarms. Prerequisites: An advanced diagnostic module is used and appropriate alarm limits are defined. See HD2-DM-A documentation.</td>
<td>0: Disabled 1: Enabled Default: Disabled</td>
</tr>
<tr>
<td>SNTP mode</td>
<td>Setting the &quot;Simple Network Time Protocol&quot; server. Match the configuration of the time server used with this setting. If an SNTP server is activated, the time is synchronized with the advanced diagnostic module to timestamp diagnostic events. Refer to the manual of the SNTP server you are using.</td>
<td>0: Disabled 1: Poll 2: Listen Default: Listen</td>
</tr>
<tr>
<td>SNTP server IP 1</td>
<td>IP address for SNTP time server 1</td>
<td>Default value 0.0.0.0</td>
</tr>
<tr>
<td>SNTP server IP 2</td>
<td>IP address for SNTP time server 2</td>
<td>Default value 0.0.0.0</td>
</tr>
</tbody>
</table>

4.9 PROFIBUS PA Master Parameters (FAP Submodules)

Almost all PROFIBUS PA master parameters are set to default values and cannot be changed. Only the values “maximum retry limit” and “watchdog time” can be changed. We recommend to configure no less than 4 retries when operating the PROFIBUS PA installation, provided that any of the following operation conditions apply:
- High level of environmental impact
- Vibration or shock
- Field devices connecting or disconnecting regularly during operational conditions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry limit</td>
<td>Number of repeated telegrams before a device is dropped from the life list</td>
<td>Min.: 1 Max.: 7 Default: 4</td>
</tr>
<tr>
<td>Watchdog time</td>
<td>PA segment watchdog</td>
<td>Min.: 100 ms Max.: 20 000 ms Default: 3000 ms</td>
</tr>
</tbody>
</table>

The PA master address for each segment is fixed to "1".

4.10 Start-Up Behavior

After powering the Power Hub, the gateway starts to poll for connected PROFIBUS PA devices in order to generate a live list. If a connection to a PROFINET IO controller and the PROFIBUS PA devices are configured in the PROFINET IO system, the gateway starts the IO cycle on the PROFIBUS PA segments.
5 System Integration

5.1 System Integration in Practice

The system integration is mostly dependent on the control system in use. For common control systems supporting PROFINET IO, Pepperl+Fuchs provides an integration document.

For further information, contact your local Pepperl+Fuchs sales office or refer to www.pepperl-fuchs.com.

For system integration, a PROFINET GSD generator is provided. You can use this generator to generate a PROFINET GSD containing all required PROFINET GSD information of the PROFIBUS PA devices used.

The PROFINET GSD configures the communication and IO data of the gateway and the underlying PROFIBUS PA devices in the control system.

A device and communication device type manager (DTM) is provided together with the PROFINET gateway, in order to parameterize the gateway and PROFIBUS PA devices.

A web server serves as read-only access point for information on and diagnostics of the gateway, PROFIBUS PA devices, and physical layer conditions of the PROFIBUS PA segments.

Figure 5.1 PROFINET IO topology

5.2 PROFINET GSD File Generator

For integration into PROFINET IO systems, a PROFINET GSD (“GSDML”) is required for the gateway. This GSDML file contains gateway-specific information, and GSD file information of the PROFIBUS PA devices used. The PROFINET GSD file generator is a PC-based software that generates the GSDML.

Ensure that you have the GSD files of all PROFIBUS PA devices in use.

The GSDML file can be changed or updated.

The name of the GSDML file is defined by the PROFINET GSD file generator and follows the GSDML specification for PROFINET.
We recommend to use this file name unchanged according to this convention to ensure that all system configuration tools handle the GSDML file name the same way.

**Example of a GSDML File Name**

<table>
<thead>
<tr>
<th>File type</th>
<th>Version of GSDML specification</th>
<th>Device information</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>GSDML-</td>
<td>V2.31-</td>
<td>Pepperl+Fuchs-HD2-GTR-4PA.PN</td>
<td>20151218</td>
<td>100559.xml</td>
</tr>
</tbody>
</table>

---

### PROFINET GSD Generator

1. "PROFINET GSD file" dialog section: For generating, opening, or deleting GSDML files.
2. **New** menu item: Generates a new GSDML file.
3. **Open** menu item: Opens an existing GSDML file.
4. **Save** menu item: Saves a GSDML file.
5. **Remove device** menu item: Removes selected GSD file of a device from the PROFINET GSD file.
6. "GSD Browser" dialog section: For listing, viewing, and selecting GSD files to be added to the PROFINET GSD file.
7. **Add to PROFINET GSD** menu item: Adds a selected GSD file to the PROFINET GSD file.
8. **Show Details** menu item: Shows the content of a selected GSD file.
9. **Search** menu item: Used to browse the GSD file list.
10. **Settings** menu item: Filter for PROFIBUS PA files and optional GSD file localization.
11. **Select Folder** menu item: Opens the directory for selection of a folder.
12. **Change to Parent Folder** menu item: Quick selection option for the parent folder.

The PROFINET GSD file generator supports language-specific GSD files.
Generating a PROFINET GSD File

1. In order to start the PROFINET GSD generator, double-click on `ProfinetGsdGenerator.exe`.

2. In the PROFINET GSD File dialog section: In order to change an existing PROFINET GSD file, in the menu choose `Open` and go to the directory where the PROFIBUS PA GSD files are located.

3. In the GSD Browser dialog section: In order to navigate to and open the directory with PROFIBUS PA GSD files you require for your project, use `Select Folder` and, if needed, `Go to Parent Folder`.

   → A list with all the GSD files opens in the GSD Browser dialog section.

4. Optionally, use the `Settings` menu item to specify which kind of files are supposed to be selected: Narrow the selection down to specifically localized GSDs or PROFIBUS PA files only.

5. Optionally, use the `Details` menu item to view the content of a selected GSD file.

6. In order to add a specific GSD file to the PROFINET GSD file, choose `Add to Profinet GSD`.

   → The added GSD file appears in the PROFINET GSD File dialog section.

7. Repeat the file selection for all PROFIBUS PA GSD files required.

8. Save your PROFINET GSD file with the `Save` menu item.

9. Ensure that you transfer the PROFINET GSD file to your system engineering station. For more information, refer to the specific system integration documentation of your application.
5.3 PROFINET Redundancy Concepts

The HD2-GTR-4PA.PN gateway supports S2 redundancy according to the PROFINET specification. A redundant pair of PROFINET IO controllers is connected to 1 gateway each at 1 port.

S2 System Redundancy

Figure 5.2 HD2-GTR-4PA.PN gateway in S2 redundancy according to the PROFINET specification
Redundant PROFINET communication can also be implemented via a so-called media redundancy protocol (MRP) topology. The HD2-GTR-4PA.PN gateway supports MRP in a ring according to the PROFINET specification.

For more information, refer to the specific control system documentation of your application.

**MRP Ring Redundancy**

![PROFINET IO Controller](image1)

![PROFINET IO Controller](image2)

Figure 5.3 HD2-GTR-4PA.PN gateway in MRP ring redundancy according to the PROFINET specification
6 PROFIBUS Commissioning

6.1 Device Type Manager (DTM): Installation and Commissioning

System requirements for installation, commissioning, and operation of the DP/PA gateway device type manager (DTM):

- Hardware requirements based on your FDT frame application
- FDT frame application (FDT specification 1.2)
- Latest version of the HD2-GTR-4PA.PN DTM
- 40 MB free hard drive storage

Installing the DTM Package with PACTware™ (Example)

In order to install the DTM package on your system, proceed as follows:

1. Install the P+F-FieldConnex® DTM package.
2. Start the PACTware™ program.
3. Update the device catalog.
   
   The Create new device catalog window appears:

   ![Create new device catalog window]

   4. Confirm with Yes.
   
   The device catalog is installed and ready for operation.

Note!

Sometimes, the FDT application does not immediately display the address change in the project window, even though the change has been made. If that happens, save the project once to refresh the display.

6.2 PROFINET DTM Project

This section explains how to generate a project tree, using PACTware™ as an FDT example.

Creating the PROFINET DTM Project Tree

In order to create the PROFINET DTM project tree, proceed as follows:

1. Start PACTware™.
   
   Note: Make sure the latest DTM version is installed and that the device catalog is updated.
2. In order to view the project tree, choose View > Project. Alternatively, press <F2>.
3. Open the appropriate project or create a new one via File > New or File > Open.
5. Open the menu entry PEPPERL+FUCHS GmbH.
6. Select the entry **Driver > PNIO Comm DTM**.

7. Add the **PNIO Comm DTM** to your project window below **Host PC**. You can do this in any of the following ways: drag and drop the DTM, double-click on the DTM, or click on **Host PC**, and choose **Add device > PNIO Comm DTM**.

### 6.3 DTM Offline Project Tree

In your FDT application you have the option to generate the project tree in different ways. The following section explains the offline generation.

**Creating the Project Tree Offline**

Ensure that you have created the PROFINET DTM project tree, see chapter 6.2. Ensure that the PNIO Comm DTM line remains active, and proceed as follows:

1. In the Device catalog, open menu item **Pepperl+Fuchs GmbH > Device > HD2-GTR-4PA.PN**.

2. Drag and drop or double-click the **HD2-GTR-4PA.PN** in order to add it to the **PNIO Comm DTM** node in the project window.
Your project tree now looks like this:

3. With the `HD2-GTR-4PA.PN` line active, you can now add field devices or diagnostic DTMs in either of the following ways: In the Device catalog, open menu item `Pepperl+Fuchs GmbH > Device > ...` and select the device you would like to add by double-clicking on it or dragging and dropping it into the project tree. Alternatively, open the context menu and select `Add Device`.

4. When adding a field device, you are prompted to select the segment that the field device is connected to. Select the appropriate segment, and click `OK`. 
The field devices are successfully added to your project tree.

6.4 PROFINET Gateway Addressing

You can address the PROFINET gateway either by entering the assigned tag name or the IP address of the gateway into the DTM.

Entering an Assigned Name or IP Address in the DTM

Proceed as follows:

1. Double-click on PNIO Comm DTM in the project tree.

   → The Parameter dialog opens.

2. Set the gateway address via either of the following options.

   Note: If you intend to use addressing via tag names, ensure that the IP address field is "{auto}".

HD2-GTR-4PA.PN DTM configuration options for addressing the gateway

1. Tag name assigned to the gateway
2. Gateway IP address

→ If you use PACTware tag names addressing, the DTM checks the device names against the PROFINET naming rules. In case identical device names are found, they are highlighted accordingly. You need to resolve this redundancy accordingly.
6.5 Topology Scan

The DTM provides a topology scan wizard to detect and store the device structure of the scanned network in an FDT project. The scan is performed independently on each level for the communication DTM, the PROFINET gateway, and the advanced diagnostic module.

Once the scan is complete, the wizard shows the differences between the scanned network and the FDT project.

Detected devices are categorized as follows:

■ Configured devices: Devices found on the network as part of the FDT project.
■ New devices: Devices found on the network without being part of the FDT project. For the devices, DTMs are available in the device catalog.
■ Uncataloged devices: Devices found on the network not part of the FDT project. For the devices, no DTMs are available in the device catalog.
■ Missing devices: Devices that are part of the FDT project but are not found on the network. If required, select or unselect these devices before completing the network configuration.

Click on **Next** to store the selected network structure in the FDT project or **Cancel** to leave the FDT project unchanged.

The topology scan function on the PROFINET COM DTM level does only support the scan of HD2-GTR-4PA.PN devices.

Creating the Project Tree Online (Topology Scan)

In order to create the complete project tree online, ensure that you have created the PROFINET DTM project tree, see chapter 6.2. Ensure that the PNIO Comm DTM line remains active, and proceed as follows:

1. Right-click on the PNIO Comm DTM, and go to **Additional Functions > Topology Scan**. The topology scan wizard opens.
2. Click on **Start**. The wizard scans the network and detects the device topology.
3. After the scan is complete, the wizard shows the differences between the scanned network and the content of the FDT project. Choose whether to select/unselect all missing or new devices etc. and click **Next**.
4. Once the gateway is detected, click on **Next** and have it added to your project tree. Close the Topology Scan dialog.

5. In the project tree, go to the gateway and double-click to connect it. In order to scan the topology for the field devices and the advanced diagnostic module (ADM), from the context menu, again select **Additional Functions > Topology Scan**.

   ➞ The Topology Scan dialog opens and detects the remaining new or missing devices connected to the PROFINET gateway.

6. Make your settings and click on **Next**. Close the Topology Scan dialog.

   ➞ The selected field devices and ADMs are added to your project tree.
6.6 PROFINET Identification and Maintenance (I&M)

You can change the PROFINET I&M information.

Setting or Changing PROFINET Identification and Maintenance (I&M) Information in the DTM

Proceed as follows:

1. Double-click on **HD2-GTR-4PA.PN** in the project tree.
   - The Parameter dialog opens.
2. You can now set or change the tag function, tag location, the date of the tag, and the descriptor information as required.
3. Confirm the parameters with **Apply**.
7 Diagnostic Information and Troubleshooting

Diagnostic information is available for the following components:

- Field devices
- PROFIBUS PA infrastructure components
- Gateway
- PROFINET and PROFIBUS PA network

The diagnostic information is made available at different levels of the PROFINET infrastructure.

The diagnostic information is propagated throughout the user interface of the web server/device type manager in form of NAMUR icons.

NAMUR Icons - Quick Diagnostic Information Reference

<table>
<thead>
<tr>
<th>NAMUR NE107 Icon</th>
<th>Diagnostic information</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅</td>
<td>Good: No failure</td>
</tr>
<tr>
<td>🔄</td>
<td>Maintenance required: Maintenance demanded, Maintenance</td>
</tr>
<tr>
<td>🔄</td>
<td>Out of specification: Invalid process condition</td>
</tr>
<tr>
<td>✗</td>
<td>Failure: Maintenance alarm</td>
</tr>
</tbody>
</table>

7.1 PROFIBUS PA Device Diagnostics

PROFIBUS PA SLAVE_DIAG data is mapped to PROFINET diagnostics alarms as defined in the PROFIBUS PA GSD file. Channel–specific diagnostics for PROFIBUS PA devices is not supported. The diagnostic information is accessible at the PROFINET IO controller and engineering station.

Refer to the documentation of the control system used and the control-system specific application document provided by Pepperl+Fuchs. If a device type manager (DTM) is available for a PROFIBUS PA device, diagnostic information is also provided by the gateway DTM.
7.2 Gateway Diagnostics

**PROFINET DAP Module Channel Diagnostics**

For the gateway and the motherboard, diagnostic information is available and mapped to the DAP module channel diagnostics. The information is also available in the gateway device type manager and web server.

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Severity</th>
<th>ChannelDiag ErrorType</th>
<th>Possible Root Cause</th>
<th>Remedy/Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware updated need reboot</td>
<td>Maintenance required</td>
<td>0x0103</td>
<td>The firmware version has been updated.</td>
<td>Reboot.</td>
</tr>
<tr>
<td>ADM error or module missing</td>
<td>Maintenance demanded</td>
<td>0x0104</td>
<td>The advanced diagnostic module reports an error to the gateway.</td>
<td>For further analysis, access the diagnostic module via the diagnostic manager.</td>
</tr>
<tr>
<td>ADM system maintenance required</td>
<td>Maintenance required</td>
<td>0x0105</td>
<td>The diagnostic module reports a &quot;Maintenance required&quot; alarm for the Power Hub hardware.</td>
<td></td>
</tr>
<tr>
<td>ADM system out of service</td>
<td>Maintenance demanded</td>
<td>0x0106</td>
<td>The diagnostic module reports an &quot;Out of specification&quot; alarm for the Power Hub hardware.</td>
<td></td>
</tr>
</tbody>
</table>
PROFINET FAP Module Channel Diagnostics

For each PA segment, diagnostic information is available and mapped to the FAP module channel diagnostics. The information is also available in the gateway device type manager (DTM) and web server.

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Severity</th>
<th>Channel Diag ErrorType</th>
<th>Possible Root Cause</th>
<th>Remedy/Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>No slave in life list</td>
<td>Maintenance demanded</td>
<td>0x0006</td>
<td>No PA devices connected to the segment.</td>
<td>Check connections of the PA devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No connection to the field infrastructure.</td>
<td>Check connection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Device couplers are defective.</td>
<td>Check device couplers and replace if needed.</td>
</tr>
<tr>
<td>Watchdog time too short</td>
<td>Maintenance required</td>
<td>0x0200</td>
<td>The watchdog time of the specific PA segment master is too short.</td>
<td>Increase the master parameter “Watchdog time [ms]”.</td>
</tr>
<tr>
<td>PA master not in token ring</td>
<td>Maintenance required</td>
<td>0x0201</td>
<td>Token handling with a second PA master is not correct.</td>
<td>Check token handling.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PA master MAU is defective.</td>
<td>Check gateway hardware and replace if needed.</td>
</tr>
<tr>
<td>Segment MAU error</td>
<td>Fault</td>
<td>0x0202</td>
<td>Gateway hardware is defective.</td>
<td>Check gateway hardware and replace if needed.</td>
</tr>
<tr>
<td>ADM segment maintenance required</td>
<td>Maintenance required</td>
<td>0x0203</td>
<td>The diagnostic module reports a “Maintenance required” alarm for the specific PA segment.</td>
<td>For further analysis, access the diagnostic module via the diagnostic manager.</td>
</tr>
<tr>
<td>ADM segment out of specification</td>
<td>Maintenance demanded</td>
<td>0x0204</td>
<td>The physical layer diagnostic module reports an “Out of specification” alarm for the specific PA segment.</td>
<td>For further analysis, access the diagnostic module via the diagnostic manager.</td>
</tr>
</tbody>
</table>
PROFINET PROFIBUS Slave Channel Diagnostics

For each PROFIBUS PA slave, diagnostic information is available.

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Severity</th>
<th>ChannelDiagnostic ErrorType</th>
<th>Possible Root Cause</th>
<th>Remedy/Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication error</td>
<td>Fault</td>
<td>0x0013</td>
<td>The physical connection between the gateway and the PA slave is lost or loose.</td>
<td>The the wiring of the gateway.</td>
</tr>
<tr>
<td>PRM fault</td>
<td>Fault</td>
<td>0x0300</td>
<td>Parameter data sent to the PA slave is incorrect.</td>
<td>Check the parameterization of the gateway.</td>
</tr>
<tr>
<td>CFG fault</td>
<td>Fault</td>
<td>0x0301</td>
<td>Configuration data sent to the PA slave is incorrect.</td>
<td>Check the configuration of the gateway.</td>
</tr>
<tr>
<td>PA slave diagnostics error</td>
<td>Maintenance required</td>
<td>0x0304</td>
<td>External diagnostic bit of the PA slave is set.</td>
<td>Check the content of the diagnostic message sent by the PA slave for details.</td>
</tr>
<tr>
<td></td>
<td>Maintenance demanded</td>
<td>0x0303</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fault</td>
<td>0x0302</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PROFINET parameterization error</td>
<td>Fault</td>
<td>0x0010</td>
<td>The parameterization data sent by the PROFINET controller is not correct.</td>
<td>Check the contents of the PROFINET GSD file.</td>
</tr>
</tbody>
</table>

Table 7.1 * Depending on the data that the slave reports back. For diagnostic details see PA profile 3 diagnostics

7.3 Diagnostics Indicated via LEDs

The gateway provides LEDs showing status and diagnostic information about the gateway itself, the PROFINET communication and the 4 PROFIBUS PA segments.

<table>
<thead>
<tr>
<th>LED</th>
<th>Information</th>
<th>Symptom</th>
<th>Possible Cause/Status</th>
<th>Remedy/Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED PWR</td>
<td>Status of gateway power supply</td>
<td>Green on</td>
<td>Power available</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No power within the specification available. Gateway defective.</td>
<td>Check power supply. Restart gateway. If problem persists, send gateway to Pepperl+Fuchs.</td>
</tr>
<tr>
<td>LED ERR</td>
<td>Error status of gateway</td>
<td>Red on</td>
<td>Hardware error.</td>
<td>Check segment diagnostics for details</td>
</tr>
<tr>
<td>LED Red.</td>
<td>Status of gateway redundancy</td>
<td>n/a</td>
<td>Currently without function. Reserved for future use of gateway redundancy.</td>
<td>-</td>
</tr>
<tr>
<td>LED</td>
<td>Information</td>
<td>Symptom</td>
<td>Possible Cause/Status</td>
<td>Remedy/Next Steps</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------</td>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>LED Seg 1 ... 4</td>
<td>Status of the PROFIBUS PA segments</td>
<td>Red 2 Hz flashing</td>
<td>Watchdog time too short.</td>
<td>Increase the watchdog time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROFIBUS PA devices communication error.</td>
<td>Check the communication settings of the PA devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROFIBUS PA devices configuration or parameterization fault.</td>
<td>Check the GSDs of the PA devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Red on</td>
<td>PROFIBUS PA medium attachment unit (MAU) error.</td>
<td>Check the MAU hardware for defects.</td>
</tr>
<tr>
<td>LED ETH1 LINK</td>
<td>Connection status of Ethernet port 1</td>
<td>Green on</td>
<td>Ethernet link available.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet link available.</td>
<td>Check Ethernet connections in the network.</td>
</tr>
<tr>
<td>LED ETH1 ACT</td>
<td>Communication status of Ethernet port 1</td>
<td>Yellow on/flashing</td>
<td>Ethernet communication activity</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No communication activity.</td>
<td>-</td>
</tr>
<tr>
<td>LED ETH2 LINK</td>
<td>Connection status of Ethernet port 2</td>
<td>Green on</td>
<td>Ethernet link available.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No Ethernet link available.</td>
<td>Check Ethernet connections in the network.</td>
</tr>
<tr>
<td>LED ETH2 ACT</td>
<td>Communication status of Ethernet port 2</td>
<td>Yellow on/flashing</td>
<td>Ethernet communication activity</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No communication activity.</td>
<td>-</td>
</tr>
</tbody>
</table>
8 Gateway Web Server

The gateway provides a web server with information and diagnostics on the gateway, the PROFINET IO network, and the PROFIBUS PA segments. Relevant product documentation can be downloaded from the gateway. The web server is intended for read-only access.

Accessing the Web Server

For access to the web server, you need to have a PC with access to the network and a standard web browser installed on it. Ensure you have the IP address of the gateway at hand. In order to open the web server interface, enter the IP address of the gateway into the browser address field.
9 Gateway Information and Diagnostics

For information purposes, the gateway can either be accessed via the web server or the device type manager. The user interfaces of both programs are almost identical. Deviations are expressly noted where they occur.

For information on how to access the web server, see chapter 8.

For information on how to access the device type manager, see chapter 6.1.

The user interface includes the following options:

1. Navigation section: Menu items for navigation to information on the device, the segments 1 ... 4, the firmware update and the documentation.

2. General information on the gateway: Description, order ID, serial number, tag, device status, segment status.

3. Contents that can be accessed via selecting a menu item in the navigation.

4. Web server only: Icon legend opens a list with all available diagnostic icons and their explanations.

5. Web server only: Contact opens the contact information for Pepperl+Fuchs worldwide.

6. Web server only:
   - Function Firmware Update to update the software of the gateway.
   - Documentation: Access to the full gateway documentation.

The following chapters explain the menu items in the left navigation bar.
9.1 Device Identification

1. Menu item "Device"
2. Identification tab
3. Section "General" with general information on the PROFINET gateway, e.g., order ID, manufacturer, etc.
4. Section "PROFINET I&M Data" (read-only in the web server user interface): Display or change information on:
   - Tag function: Describe the function of the gateway (DTM only) or view the description (web server)
   - Tag location: Define where the device with the tag is located on the gateway installation (DTM only) or view the location of the device with the tag (web server)
   - Date: Enter a date, when the tag has been defined and placed (DTM only) or view the date (web server)
   - Descriptor: Enter a descriptor of the gateway in the system (DTM only) or view the descriptor information (web server)
5. Section "Device Actions": Button Locate Device to locate the gateway in a system installation. Check whether the device is physically connected and where it is plugged exactly.
   The deactivation of the Locate Device function works differently:
   - In the web server interface: Clicking on the button causes all gateway LEDs to flash for 10 s time. The LEDs stop flashing automatically after that.
   - In the DTM interface: Clicking on the button causes all gateway LEDs to flash. In order to stop the function, click on the button again.
9.2 Device Diagnostics

Device diagnostics dialog

1. Menu item "Device"
2. Diagnosis tab
3. Section "PROFINET": Information on the PROFINET IO connections, redundancy, etc. For more information on the PROFINET IO communication profile, see chapter 3.1.
4. Section "Advanced Diagnostics Module (ADM)": Status of the advanced diagnostic module
5. Section "Device": Issues status/diagnostic information of the gateway. See chapter 7. For more information on the gateway diagnostics, see chapter 7.2.
9.3 Device Network Information

1. Menu item “Device”
2. Network tab
3. Section "IP Configuration": Displays all network details of the gateway.
4. Section "NTP Time Server(s)": Settings of the simple network time protocol (SNTP).
   For more information on gateway device parameters (DAP submodules), see chapter 4.8.
5. Section "Network Neighborhood (LLDP)”: Shows detected neighbors and their ports.
   For more information on the PROFINET IO communication profile, see chapter 3.1 and for the gateway management function, see chapter 3.3.
9.4 Segment Diagnostics

Segment diagnostics dialog

1. Menu item "Segment 1 ... 4"
2. Diagnosis tab
3. Section "General": PROFIBUS PA parameters and number of field devices, PNIO configured devices, etc. For more information on the PROFIBUS PA parameters (FAP submodules), see chapter 4.9.
4. Section "Detailed Diagnosis": List of diagnostic messages. For more information on the gateway diagnostics, see chapter 7.2.
9.5 Information on Field Devices of the Segment

While the content of the field device information is identical, the way to access the information slightly differs in the DTM and in the web server user interface. Parameter settings can only be changed in the DTM.

Device Type Manager Information Dialog on Field Devices of the Segment

1. Menu item "Segment 1 ... 4"
2. Field Devices tab
3. Live list with the field devices: Lists all devices connected to the segment, their identifiers, and the state of the PA master. Clicking on any heading of the column sorts the active column alphabetically/numerically. Clicking on an entry in this list dynamically provides information on the selected field device in the subsequent sections of this dialog.
   For more information on the live list, see chapter 4.10.
4. Section "Device Data":
5. Section "Device Diagnosis": Shows the diagnostic status of the selected device, including the NAMUR icon. This information is added up and propagated as a diagnostic state icon for the segment in the left navigation menu and the general top navigation section.
   For more information on the NAMUR icons, see chapter 7.
6. Section "Device Status": Shows details on the status of the selected field device.
7. Section "Diagnosis Frame Bytes": Content of the PROFIBUS PA diagnostic telegram. PROFIBUS experts use this information for troubleshooting.
8. Section "PROFIBUS 'Set Slave Address'": Address assignment for PROFIBUS PA devices.
   For more information on addressing, see chapter 4.6.
Web Server Information Dialog on Field Devices of the Segment

Figure 9.1 Web server user interface dialog  Segment 1 ... 4 > Field Devices

1  Magnifying glass symbol for access to the device details
2  Navigation to page through the Device details dialog of all devices in the list or to close the dialog.

Click on the Magnifying Glass symbol (1) to access the Device details dialog tab.
Use the navigation symbols (2) on the top right of the Device details tab to page through the details of all devices in the list or to close the tab.
9.6 Gateway Firmware Update (Web Server Only)

It may be necessary to update the firmware of the gateway from time to time. This function is exclusively accessible via the gateway web server.

Updating the Firmware

In order to update the gateway firmware, access the web server user interface of the gateway.

1. From the left navigation bar, select **Firmware Update**.

2. Click on **Browse** and select the new firmware version from the appropriate directory.

3. Click on **Start Firmware Update**.

   After the gateway firmware update, you receive a success message that prompts you to reboot the device.

4. Reboot the gateway.

   The new firmware is installed.
9.7 Gateway Documentation

You can access all gateway documentation via the web server user interface. From the left navigation bar, select *Documentation*.

The documentation is also available in the DTM:

![Gateway Documentation](image)

Figure 9.2 Help menu

1 Help symbol for help on documentation
10 References

Fieldbus integration in PROFINET IO.
Version 2.0 – Date: May 2011; Order No.: 7.012.

PROFIBUS Integration in PROFINET IO Amendment 1 to Fieldbus Integration into PROFINET IO.
Version 2.1 – Date: June 2013; Order No.: 7.012.

PROFINET Design Guideline.
PNO Doc. 8.062.

PROFINET Installation Guideline for Cabling and Assembly.
PNO Doc. 8.072.

PROFINET Installation Guideline for Commissioning.
PNO Doc. 8.082.